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SOFTWARE LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS. YOUR INSTALLATION OF THE PROGRAM
INDICATES YOUR ACCEPTANCE OF THESE LICENSE TERMS.

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE INSTALLING THE PROGRAM. SOLUSTAN, INC.
WILL ONLY LICENSE THE PROGRAM TO YOU IF YOU FIRST ACCEPT THE TERMS OF THIS AGREEMENT
BY INSTALLING THE PROGRAM. SOLUSTAN, INC. PROVIDES THE SOFTWARE FOR TRIAL FOR 15 DAYS
OR 15 LAUNCHES OF THE DRIVER TO PROVE THE FUNCTIONING OF THE DRIVER ON YOUR PC BEFORE
PURCHASING THE LICENSE. ONCE THE LICENSE IS PURCHASED, IT IS NON-REFUNDABLE AND NON-
RETURNABLE.

These license terms apply to Your installation and use of the program, which program includes copyrighted materials
and programs (collectively referred to as "Program"). This license is granted to You by Solustan, Inc. You may not use
the Program contained in this Package to upgrade any existing Programs that You may have. The Programs contained in
this package are intended only for New Users of LinkMotion and/or MaxMotion and not for any other use.

1. License. This Program is licensed and not sold. Title to the Program does not pass to You. Solustan owns
copyrights in the Program. You obtain no rights other than those granted You under this Program License Agreement.
The term "Program" means the original (including any revisions, enhancements, updates, or the like) and all whole or
partial copies of it, including modified copies or portions merged into other programs. You are responsible for the use
of, and results obtained from the Program. This Program may be used only on one machine at any one time. You may
not reverse assemble or reverse compile the Program, except as specifically provided by law, without the possibility of a
contractual waiver. You may not sublicense, rent, lease, or assign the Program.

2. Disclaimer of Warranty and Limitation of Liability. THE PROGRAM AND ANY OTHER PRODUCT WHICH
WE PROVIDE TO YOU AS PART OF OUR SERVICE ARE PROVIDED "AS IS." EXCEPT AS SPECIFICALLY
SET FORTH HEREIN, NEITHER WE NOR OUR LICENSORS MAKE ANY WARRANTIES, REPRESENTATIONS
OR CONDITIONS OF MERCHANTABILITY, QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE
RELATING TO OUR PROGRAM, SERVICES, AND/OR RELATED PRODUCTS THAT WE OR OUR LICENSORS
PROVIDE.

3. INNO EVENT SHALL SOLUSTAN BE LIABLE FOR ANY DAMAGES RESULTING FROM THE USE OR
MISUSE OF THE SOFTWARE OR THE ACCOMPANYING MANUAL INCLUDING BUT NOT LIMITED TO
DAMAGES FOR INJURY TO ANY PERSON OR PROPERTY. THE PROGRAM IS DESIGNED TO WORK WITH
MACHINES AND AS SUCH, ANY PART OF THE SYSTEM MAY MISBEHAVE. IT IS IMPORTANT TO TAKE
ALL THE NECESSARY PRECAUTIONS IN OREDR TO AVOID EQUIPMENT DAMAGE AND/OR INJURY.

4. WE DISCLAIM ANY WARRANTY OF TITLE OR OTHER WARRANTIES FOR ANY THIRD PARTY'S
OFFERING(S) OR PRODUCT(S). ALL SUCH WARRANTIES AND REPRESENTATIONS ARE HEREBY
EXCLUDED. WITHOUT LIMITATION, NO WARRANTY IS GIVEN THAT THE PROGRAM OR PRODUCTS
ARE ERROR-FREE.

WE, INCLUDING OUR LICENSORS, DISCLAIM ANY LIABILITY OR RESPONSIBILITY ARISING FROM ANY
CLAIM THAT YOUR ACCESS OR USE OF THE PROGRAM, SERVICE, AND/OR RELATED PRODUCTS WE
PROVIDE INFRINGE ANY THIRD PARTY'S INTELLECTUAL PROPERTY RIGHTS.

IN NO EVENT ARE WE OR OUR LICENSORS ARE LIABLE FOR: A) DIRECT, SPECIAL, INDIRECT,
CONSEQUENTIAL OR INCIDENTAL DAMAGES EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY
THEREOF INCLUDING, BUT NOT LIMITED TO, LOST PROFITS, LOST BUSINESS REVENUE, OR FAILURE
TO REALIZE EXPECTED SAVINGS; OR, B) ANY CLAIMS AGAINST YOU BY ANY OTHER PARTY. This
Section applies to all claims by You irrespective of the cause of action underlying Your claim, including, but not limited
to: a) breach of contract, even if in the nature of a breach of condition or a fundamental term or a fundamental breach, or
b) tort including but not limited to negligence or misrepresentation.



In no event are We or Our dealers liable for any damages arising from Your failure to perform Your responsibility in
connection with this Program License Agreement, or arising from any cause beyond Our control, including but not
limited to delay in the performance of Our obligations or misuse of Your User IDs. All limitations and disclaimers stated
in this Section also apply to Our Product Licensors as intended beneficiaries of this Program License Agreement. Any
rights or limits stated herein are the maximum for which we are collectively responsible.

5. Termination. This license is effective until terminated. This license will terminate immediately without notice from
Solustan, Inc. if fail to comply with any of its provisions. Upon termination you must destroy the Software and all copies
thereof, and you may terminate this license anytime by doing so.

6. General. You are responsible for payment of any taxes, including Your personal property taxes, resulting from this
Program License Agreement or Your use of the Program. You agree to comply with all export laws and regulations.
Neither party may bring an action under this Program License Agreement more than ONE years after the cause of
actions arose. This Program License Agreement and all Your rights and obligations are governed by the laws of the
State of Massachusetts.

7. LinkMotion driver software is protected with a software protection key. The protection key is tied to your specific PC
computer using appropriate Microsoft Operating System. If the technology was not available to transfer the license to
another PC, you will be required to buy another license at a full price of the software in case of a PC failure beyond
normal repair. It is very important to safeguard the PC with the license.

8. LinkMotion driver software you purchased can also protected with optionally available hardware ID (dongle) key. If
the ID key fails for some reason, you could return it for replacement. As long as Solustan can identify the key to be the
one issued by us, we will replace it for a fee. On the other hand, if you lose the key, you will be required to buy another
license at a full price of the software. It is very important to safeguard the ID key.

Solustan, Inc. 165 Chestnut St., #200, Needham, MA 02492
Tel: 781-449-7666 Fax: 781-449-7759 EMail: support@solustan.com



LinkMotion Detail Installation and Setup Instructions

Computer Requirements:

Windows XP operating system with Service Pak 2 or 3 and Microsoft .NET 2.0 Framework installed
Processor speed of at least 800 Mhz, Minimum RAM memory 512 MB, 1 GB preferred,

40 MB of Hard drive free space, Screen resolution of at least 800 x 600,

CD-ROM drive is not required, if the driver software was down-loaded from the web site.

CD-ROM drive is necessary, if the software was received on a CD.

Microsoft NET 2.0 Framework is available for a free download from the following site:
Microsoft.com>Downloads & Trials>Download Center>.NET Framework Version 2.0
Com Port or Parallel Port required depending on your Vinyl cutter’s specifications.

Installation required for LinkMotion Vinyl for HPGL controller:

Part 1 - First part is installation of LinkMotion Vinyl cutting software.

Part 2 - Software License Code procedure is necessary for full working license.

When you install the LinkMotion software on your computer it is good for 30 days or 30 executions.
Within this period you need to get a license code from Solustan to make it a permanent license for the
computer of your choice. Please make sure and install on the computer that you are planning to use
for long term. All LinkMotion product Licenses are non-transferrable. Price is subject to change
any time. Additional software licenses can be made available for an extra charge.



Part 1 - Installation Procedure for LinkMotion Vinyl cutting for HPGL machines:

Note that you must have administrative privileges on the computer in order to install LinkMotion.
Most of the installation process is self-explanatory by following the instructions from the screen. You
can stop the installation at any time by clicking "Cancel".

If you have received the driver software on a CD then follow steps from (1A). If you have down
loaded form the web then go to step (1B).

(1A) Insert the LinkMotion installation CD into your CD-ROM drive. If the Auto-run feature is
enabled, Windows will start the Installation automatically. If the Auto-run feature is not enabled, browse
the CD drive in Windows explorer and double-click on the "Launcher.exe" and installation will begin.
or

(1B) After downloading, unzip the files and save them by creating a folder name LinkMotion. Now
double click on the file name Setup.exe or Launcher.exe and installation will begin.

(2) Click on the Next Button.

i LinkMotion

Link & Motion™
A

£\

SoLusTtaN, INc.

(3) Click on the Next Button.

i LinkMotion

Welcome to the LinkMotion Setup Wizard A\

The installer will guide you through the steps required to install LinkM ation on your computer.

WARNIMG: This computer program is protected by copyright law and international treaties
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted ta the maximum extent possible under the law.

e CHeek T




(4) When you get to the License Agreement dialog (see above), you must read the agreement. If you
agree, go ahead and click the radio button, "I Agree" for the installation process to continue. Then

Click on the Next Button.

Ié .LinkMotion @|§|g}
& .

License Agreement \

Please take a moment to read the license agreement nowe. If you accept the terms belaw, click "'l
Agree”, then "Newt". Otherwise click "Cancel”,

SOFTWARF LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERRMS. YOUR
INSTALLATION OF THE FROGEAN INDICATES YOUR ACCEPTANCE OF
THESE LICENSE TERMS. FPLEASE READ THIS AGREEMENT CAREFULLY
BEFORE INSTALLING THE PROGRARM. SOLUSTAN, INC. WILL ONLY LICENSE
THE PROGEAN TO ¥OU [F ¥OU FIRST ACCEPT THE TERIMS OF THI
AGREEMENT BY INSTALLING THE PROGEAM. SOLUSTAN, INC. PROVIDES
THE SOFTWARE FOR. TRIAL FOR. 15 DAYS OR. 15 LAUNCHES OF THE DRIVER.

TC PROVE THE FUNCTIONING OF THE DRIVER. ON YOUR PC BEFORE bt

" | DoMat Agree

Cancel < Back | Mest » |

(5) After you have read and agreed to the License Agreement, you will be asked to specify the
installation folder. In most cases you can leave this at the default settings. You will also be asked to
specify who will be able to run LinkMotion on this computer. In most cases you should specify
"Everyone" and then Click on Next button.

|§ .Linldlotion . @li‘@
7S .

Q.e]_e.c_t Installation Folder \

The installer will install Linkh otion to the following folder,

Toinstallin this folder, click "Mext”. Toinstall to a different folder, enter it below or click "Browse".

Folder:

C:A\Program Files\Solustan'LinkMaotion’ Browse...
Disk Cast...

Install Linkkotion for yourself, or for anyone who uses this computer

+ Eveone

T Just me

= e e Hext)

(6) Click on the Next button once again.



1% LinkMotion

The installet is ready to install LinkMation on your computer.

Click "Mext™ to start the: installation

Eera) <Bak | Nats

(7) Later during the installation you will be asked to Choose your application and Choose your
machine for installation. Application name is Vinyl Cutting Machines and user needs to choose their
machine name. If you do not see your machine name you can contact us and we can help you.

Choose your Application.and Machine

hoose wour application | HPGL Controller For Miny| cutters _vJ

Choose wour machine

(8) During installation, if a dialog pops up warning you that you are installing an untested driver, click
on "continue anyway". This warning will be removed in a future release.



Hardware Installation

L ] E The software you are installing for this hardware:
L

Printers

haz not pazzed Windows Logo testing o werify its compatibility
with Windowsz P [Tell me why this testing iz impartant. |

Continuing your installation of thiz software may impair
or destabilize the correct operation of your syztem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
paszed Windows Logo testing.

Continue Arpmaway ] [ STOR Ingtallation

(9) Click on "Close" when the installation is complete.

LinkkMotion has been successfully installed

Click "Cloze’" to exit

Pleasze uze ‘Windows |Jpdate to check for any critical updates to the MET Framework.

Icon shown above should show up in system tray at the bottom right.

(10) Setting up the Default Printer:



You want the LinkMotion printer to be your default printer. Go to the Start button and open the "Control
Panel>Printers and Faxes" menu and find the printer driver with your machine name. Example
shown here has Roland CAMM 1/24 name. Right click on this printer and select "Set as Default
Printer".

*& Printers and Faxes @@l@
l'f

i Fle Edit WVew Favorites Tools  Help
i @Back il ﬁ -~ Search Folders El- A
2 V| pleserlet2i005eriesPCLE | | POFSSS
1 ISErJe L ~eries FCL 2
Printer Tasks rﬁ“' — 0 = = = — 0
VG T ; =i
u \_9 .da]dt.N“MiJZ \_\  POFCreator
=
L It
L K
e =
Other Places 3 |
v £ »
Status: Ready Documents: O

(11) Post-installation setup and configuration:

For all HPGL Vinyl cutting machines you must tell the printer driver which port the machine is
connected to. (LPT or COM Ports) Usually this will be one of the parallel or serial ports. To set up the
printer driver, open the "Control Panel>Printers and Faxes" menu and find your printer with Your
machine name; right click on this printer and select "Properties". Select the "Ports" tab and select
your port. Our installation is on Nul port but you can change to Com or Parallel port where you have
connected your machine.

& Roland CAMM 1/24 Properties

Color Management Device Seftings

General Sharing Ports Advanced
@
\:7\5 Roland CAMM 1/24
Print to the following port(s). Documents will print to the first free
checked port.

Part Diescription Printer ~

COM1: Serial Port

O FILE:  Printto Fis

O IP_1... Standard TCP/IF Pott  HP Laser)et 2100 Seres PC...

O POF.. PDFCreator Redirec.. PDFCreator

O POF.. Local Pot PDF395

O NUL  Local Port Roland CAMM 1/24

O VAP, Local Pott M
[ Add Port... ] [ Delete Port ] | Configure Port... |
[] Enable prirter padling

Close Aophy




Don't forget to configure the com port for the proper baud rate, data bit, parity, stop bit and Hand
Shake information that is necessary. Parallel port does not require this kind of settings.

COM1 Properties

Port Settings

Bits per second: v
Data bits: | 8 v
Party: | None v

Stop bits: |1 w

Aow control: | Hardware g

Restors Defaults

(12) International Customers need to check following:
If you are using Windows operating system for other languages please make sure that following settings
are selected for LinkMotion to work properly.

Win XP: Go to the Start button > Control Panel > Regional and Language Options > Click on the
Customize button. Here Decimal Symbol should be .(Full stop or Period) selected. Do not select
(Comma). If you had to change click on the Apply button and Click OK.

Installation and setups are complete.

Now refer to Using LinkMotion and the design application you are using and how that works with
LinkMotion and Popular Applications. Document names are as following:

LinkMotion and Corel Draw
LinkMotion and Illustrator and more....
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Uninstalling LinkMotion:

Please make sure of the following before you uninstall:

Your specific machine related settings are saved as LinkMotion.ini file. This file can be saved from
General Options Menu and simply click on the Save button and give whatever name you prefer. You
can also navigate where in your hard drive you want to save it. Different users can save under different
names. Similarly you can Load that file back after another installation of LinkMotion by going to the
General Options menu and clicking on the Load button. Navigate to the file from your computer where
you saved it earlier. Restore Default button allows you to load default installed INI file that is supplied
with LinkMotion. It is very important to exit LinkMotion applet and Re-launch the applet when
you make any changes for it to be effective.

Uninstall LinkMotion Procedure:

Make sure the LinkMotion applet is closed. Open the Start menu and select the Control Panel.
Double-click on Add or Remove Programs. Look for LinkMotion entry in the list and click on that.
Select "Remove" and answer "Yes" when it asks you if you really want to remove LinkMotion.

LinkMotion.INI file (configuration file) does not get deleted with uninstall

procedure. If you want to delete your existing INI file following is the procedure:
In the hard drive Find folder name Document and Settings> Folder with users (your own name)
name> Folder name Application Data> Folder name Total Graphics Network> Folder name
LinkMotion> LinkMotion.INI. Delete this file.

Re-Launch LinkMotion:

It is extremely important to Re-Launch LinkMotion if you replace or change LinkMotion.INI file
for it to be effective.

Exit the LinkMotion (icon) applet by right mouse click from the systems tray at the bottom right.
LinkMotion icon should go away from the systems tray.

Now launch it back again by following and selecting the path Windows Start button>Program
Files>Solustan>LinkMotion by the arrow of your mouse.

LinkMotion icon should appear again in the systems tray at the bottom right.

1"



Part 2 — Software License Key Procedure

We welcome you for trying out our LinkMotion driver software. You will see the following message on
the screen when LinkMotion is launched from the systems tray every time when you are using the
program as demo.

Reminder,

Thank you For evalusting LinkMotion. You have LS days or 15 launchings of the LinkMation applet ko evaluate, You can purchase the
licerse for unlimited use of the LinkMotion driver at anvtime For this PC.

R Entergey| ﬁuyan‘|

Click on the Enter key button, whenever you decide to purchase or you have purchased it and you are
ready for full license key. Enter Key will open following dialog box and show the Hardware
fingerprint of your computer. -

Enter Key

Enter the registration name and key below, exactly az given to
you

Hardware fingerprint: CBBS-7103

You need to provide us the proper information for Hardware fingerprint, Business Name, valid email
for Business along with the LinkMotion version and operating system you are using. Fill out this
information in each respective boxes, save the file and email it to us at support@solustan.com. Solustan
is not responsible for any incorrect Hardware fingerprint code you provide. Please double check
this information before you send it to us. Software license working with Hardware fingerprint and
matching code provided by Solustan, Inc. is intended to work only on the computer with the proper
hardware fingerprint. Key Code will not be generated for any incomplete information.

All LinkMotion product licenses are non-transferrable. User will need to buy another license for
another computer. Additional license can be made available for an extra charge.

Hardware fingerprint:

Name: (Business name or Computer user’s name)

Valid email for Business or User:

12



Your Operating System: Win 7 64 Win 7 32 Win XP

Your LinkMotion Application:

LinkMotion USB Laser LinkMotion USB LinkMotion Lite
LinkCAM M&G LinkMotion VC-Laser LinkMotion VC
LinkMotion Galvo LinkMotion HPGL Eng. LinkMo HPGLVinyl

LinkMotion USB and LinkMotion Lite users need to verify Serial number of the USB controller
card. Launch your LinkMotion application and select the Help tab(menu). Last thing at the bottom right
it displays the serial number for the USB Controller. Please write this serial number in the box below.

USB Controller Serial Number:

After you send us all of the information in above boxes, we will send you the customized Key Code.
This key code is long text containing numeric numbers as well as alphabet letters.

Key: (Key Code for LinkMotion License)

We highly recommend that you simply copy and paste this in the Key section by bringing back the
same Enter Key screen. Click OK and you are ready to use your LinkMotion driver software license.

If you did not purchase within 30 days or 30 launchings you will see a last reminder as seen in the
following picture. It will be best to purchase at this point.

g\ Youhave 1 dey(s) et on your temporary key.
.
I - [
Eniter Key | S Buy Mowt

Once the trial period of LinkMotion expires, you will see the following message.

Key Expired

Vuurtempurarykeyh e d IFy believe this please contact the distributor, It is
!} sy o purchase the licef a8 i pECH I o Unfac mpcsu thhdware
R dwewnp e e R B

Enter Key ‘ By Mow! ‘

Click on the Enter key will always give you the Hardware Fingerprint and you can purchase the
software any time if you were using the trial version.
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LinkMotion driver for Vinyl Cutting machines with HPGL style
Controllers:

The LinkMotion driver comes with a small applet that resides in the System Tray. The System Tray is
the lower right bar of the Windows screen. Double click on the LinkMotion icon to bring up the
application.

LinkMotion for Roland CAMM 1/24 - Version 2.70

Welcome IGeneral Options | Help |

L m‘ Moll

Foland CarM 124
24,00 in. max. material width

| 64 in. max, design length

| 100 % cukter speed
| |og  ecutter pressure

End of job action:

& advance the vinyl

I £l in. advance

™ Rewind winyl to re-run the job

(04 l Cancel Apply

LinkMotion Welcome:

Double click on the LinkMotion Icon in the system tray to see the screen shown above. Title shows the
name of the machine this driver is loaded for. Note the simplicity and the power of the driver. There are
just a few settings including the maximum length of the design, cutter pressure (if selectable), and the
selection of the position of the cutter at the end of the job. Detail explanation is given after general
options tab explanation.
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It is important to launch the design application like Corel Draw after you make any change to the
maximum design length for design application to recognize the new length as available area to
design the job.

The driver is configured for many machines. It is easy for the user to select his machine at the time
of installation.

The settings for different machines are saved in a file called LinkMotion.INI. This file is available
at the following location on your hard disk drive:

C:\ Document and Settings> (Folder with) computer users name> (Folder name) Application
Data> (Folder name) Total Graphics Network> (Folder name) LinkMotion> LinkMotion.INI.

If you ever need to change this file, the changes will become effective only after the user takes the
following steps:
(1) Make necessary changes to the LinkMotion.INI file and Save this file.
(2) Exit the LinkMotion Applet from the systems tray. Exit the applet using the right mouse
click on the icon and selecting Exit.
(3) Re-launch the LinkMotion Applet from the Windows Start button.

Instructions on Settings are as follows:

General Options tab:

LinkMotion for Roland CAMM 1/24 - Yersion 2.70

Welcome  General Options |He|p |

Units \lnches LI LIS

iches Save Load Restore Defaults
centimeters
millimeters

QK I Cancel Apply
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The driver is designed to work with inches, millimeters or centimeters. Make your selection and click
on the Apply button.

It will be convenient to use both LinkMotion driver and design program like Corel Draw to be working
in the same selection of measurements. (Inches, mm or cm)

Settings:

Save:

Once the machine is properly configured and is working well, it is advisable to Save the settings on
the hard disk drive. This is saved as LinkMotion.INI file.

LinkMotion.INI file is located on your hard drive C:\ Document and Settings> (Folder with)
computer users name> (Folder name) Application Data> (Folder name) Total Graphics Network>
(Folder name) LinkMotion> LinkMotion.INI.

Click on the Save button and it will ask you to give a file name. Make sure to remember the file name,
and where you are saving it. You can navigate on your hard drive where you want to save. You can also
rename the file with what ever is easy for you to remember. Mostly our customers rename the file with
their machine name.

Load:

In case the LinkMotion needs to be loaded again or you need to load upgraded version the user
will be able to reload all the settings with your .INI file without wasting any time. For loading the
settings back select Load button and navigate to the saved .INI file and click on Apply and OK. Now
click on the right mouse button when you are on the LinkMotion appellate and exit the program. Go to
the start button and launch back LinkMotion. You should see all your saved settings here now.

Restore Defaults:

Clicking on this button will load default LinkMotion.INI file that we supply with the LinkMotion
driver application.

It is very important to exit LinkMotion applet and Re-launch the applet when you change and

select another INI file for it to be effective. Design application should be launched after the proper
INI file is selected.

LinkMotion Welcome tab:

16



LinkMotion for Roland CAMM 1/24 - Version 2. 70

Welcome ]General Opkians | Help |

Lin <= Mo on™
Driver
A

| Roland cAMM 1j24
24,00 in. max, material width

I &4 in, max, design length

I 100 % cutter speed
I 10 e cutberpressure

End of job action:
@ advance the vinyl

£l in. adwance

" Rewind vinyl to re-run the job

’TI Cancel &pply

Every cutter has physical limit to the maximum width of material it can handle. However, the length of
the design can vary. An appropriate number would be the length the material that can be tracked
successfully by the machine. Anytime you make this change in the value for the length you need to
make sure to launch design application like Corel after the change is effective in LinkMotion
driver.

The Cutter speed can be set as a percentage of maximum speed specified by the manufacturer.

The Cutter pressure can be set as a percentage of maximum pressure specified by the manufacturer.
This setting is grayed out and not selectable in case of the machines where the controller does not permit
software setting of the pressure. In such a case, either the download pressure is fixed or selectable on the
machine.

End of job action displays two radio buttons in the picture shown above. These two radio buttons are
for selecting the positioning of the cutter at the end of job. Either Advance the vinyl at the end of job by
a specified distance or Rewind the vinyl to bring the cutter back to the beginning of a job.

End of job action displayed in the picture below shows only one check box for Rewind vinyl to re-
run the job. Controller for Graphtec 50 vinyl cutter takes care of positioning of the tool at the end of
job so we give you only one choice to Revind the vinyl to re-run the job. User can check or uncheck this
box depending on their need.

17



LinkMotion for loline Studio 7724 - Yersion 2. 70

Welcame |Genera| Optionsl Help I

Toling Studio 7724
24,00 in. max, material width

| &4 in. max, design length

I 100 9 cutter speed
I? S cuther-pressure

End of job action;

W Rewind vinyl to re-run the job

(04 I Zancel | apply |

Any of the changes made in any of the settings require for user to click on the Apply button for it
to be effective.

18



Application Compatibility with LinkMotion:

Go to www.solustan.com/support and download instructions for the appropriate design application you
might be using. Some applications have their own limitations and mostly it is listed in the document.
We are adding information as we test with respective applications.
Solustan tests the primary function of accepting hair lines (vector lines) from the third party application
software to make the vector moves on the machine using LinkMotion driver. Solustan may test
additional functions. However, it is not a detailed testing. The developer and marketer of the third party
software make changes to their applications quite often. It is the responsibility of the user to make sure
that the necessary functions are available while making the choice of off-the-shelf application software.
Solustan's liability is limited to the purchase price of the LinkMotion driver software.

1. Corel Draw version 9, 10, 11, 12, X3, X4 and X5

2. Corel Paint Shop Pro (Raster Only)

3. Adobe Illustrator

4. EngraveLab / SignLab version 6.0 and higher

5. FlexiExpert

6. FreeHand MX

7. Gerber ArtPath and Composer

8. Vinyl Express

9. Xenetech

10. AutoCAD version 2000 and higher

11. DesignCad

12. DolphinCAD specially designed version for LinkMotion

13. Instant Engineer 14

14. Rhino 4.0 Beta

15. IntelliCAD (AcceliCAD)

16. BarTender (Raster only)

17. Microsoft Word (Raster only)

18. PhotoShop (Raster only)

19. MaxMotion — Windows XP and 2000 (Not supported in Vista, Win 7 32 or Win 7 64)

19



Frequently Asked Questions:

Section I - Microsoft Windows configuration related questions:

1. What is the minimum configuration required for the PC?

Windows XP operating system with Service Pak 2 or higher and Microsoft .NET 2.0 Framework
installed, Processor speed of at least 800 Mhz, Minimum RAM memory 512 MB, or 1 GB preferred.
40 MB of Hard drive free space, Screen resolution of at least 800 x 600.

Service Pak and .NET 2.0 Framework are (free) downloadable from Microsoft’s website.

CD-ROM drive is not required, if the driver software was down loaded from the web site.

CD-ROM drive is necessary, if the software was provided on a CD.

2. How to check if I have installed Service Pak2 on my computer?

Go to the Start button. Select Control Panel. Select System. Now in General menu it should show if
Service Pak 2 is installed. Also you can install and uninstall by windows standard Add/Remove
program procedure. Make sure you install LinkMotion after you install windows operating system
related update first.

3. How to check if I have installed .NET Framework 2.0 on my computer?

Go to the Start button. Select Control Panel. Select Add/Remove programs. Here you should see if
you have installed the NET Framework 2.0 of Microsoft. This is required to work with our new
version of LinkMotion.

4. How can I check the processor speed and RAM memory on my PC?

Go to the Start button on the System Tray on the bottom left and select Control Panel. Select System
from the Control panel. Here you should see information for the version of your operating system and
under Computer you should see the processor speed and the RAM memory installed on your
computer.

5. How to see hidden folders in windows?
Go to the Start button. Select Control Panel. Select Tools Menu and select Folder option. Click on
the View menu. You should see a folder called Hidden files and folders. Here select the button for

Show hidden files and folders. Click on the Apply button. Now you will see all the folders. This is
useful to see the configuration file name LinkMotion.INI for LinkMotion driver application.
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Section II - LinkMotion Driver:

1. Do I need to access LinkMotion driver software once loaded?

Generally, you simply deal with your job design software and your machine. We do provide an
accompanied settings application. This application can be invoked from its icon in the System Tray area.
This application will allow you to choose a few settings for material length, cutter speed, cutter pressure
if available and end of the job parking position. Make proper selection, click on the apply button and
then start the design application.

2. How do I know if my LinkMotion is installed properly?

When you launch LinkMotion applet does it show the title “LinkMotion for Your Machine Name —
Ver. 2.7 (version that you have). If this is not proper you may have installed for the wrong
machine. You need to uninstall and re-install LinkMotion again by windows standard uninstall
procedure.

If you had a trial version you need to purchase the full working version.

3. How to see the file for my LinkMotion related configuration settings?

This file is named LinkMotion.INI.

Go to your C:\ > Documents and Settings > Folder with computer User’s name (how ever you
have set up your computer) > Application Data > Total Graphics Network > LinkMotion >
LinkMotion.INI.

This file has all your machine related settings. You can save this file under different name as well
as reload this file from where you might have saved this file.

4. I want to design in millimeters and not inches. How do I change?

Simply go to the General Options tab and change from inches to mm by clicking on the scroll down
arrow and then click on the Apply button. Similarly you can change to cm also. It is that easy.

5. I am sending a job and the machine does not come alive to execute the job. What
am I doing wrong?

This situation may occur due to any of the following:
(A) Check the power of the machine.
(B) Check the print queue for any extraneous documents and remove them.

(C) Check the feed rates and other settings to make sure that they are all correct.
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(D) Printer driver installed for your machine may not have been selected as DEFAULT DRIVER.
Please check in Control Panel>Printers and Faxes>Your Machine Driver (this should be selected
as default driver). Also make sure to set Port settings if Com port is selected for communication.

(E) You might have selected thick outline or filled object and vinyl cutters do not understand those
commands. White fill is also not proper to send the job to a vinyl cutter. Use only Hairline for any
job you design with graphics or text. If you sent the file for print by mistake with thick line or the
filled object go down to the question no. 6 and make sure you delete the file properly before
sending the new corrected file.

(F) If Service Pak 2 was not installed on your Windows XP operating system you may see the
problem of LinkMotion not sending anything to the machine. You need to uninstall the LinkMotion
and then install the Service Pak 2 and re-install the LinkMotion driver.

(G) Make sure to design the job within the size of plotting area available with your vinyl cutter.

6. I sent the job for print and I see the print spooler in the Systems Tray but
machine does not start. Why and what should I do?

Same reasons as explained in the question no. 5 above. At this point you can click on the printer spooler
and it should open on your screen. It should display the name of your file. You should select that file by
bringing the arrow of your mouse on that name and left mouse click. Now go to the Printer menu in
that dialog box and select Cancel All Documents and close that dialog box. Windows takes a few
minutes to clear this file from the spooler and that is dependent on the file size. This should make the
spooler go away from the systems tray. If you do not see that happening if your file was too large.
You can Exit LinkMotion and Re-Launch it from the Start button and it will speed up the delete
process for the file from the spooler. Now you are ready to work again from Corel application.

7. Why is the Material Width setting fixed for my vinyl cutter?

Maximum allowable width is displayed as a fixed number for your vinyl cutter. This number is taken
from the specifications of the manufacturer. This prevents you from making a mistake of sending any
larger size job. User can always design the job in smaller width material and make adjustment for the
output in Layout tab of the Print dialog box for proper output.

8. What procedure should I follow to change the length of a job?

When you load this LinkMotion driver for your machine it loads the default maximum recommended
length suggested by the machine manufacturer. User can change and place any length they want. If it is
shorter then what is recommended it is fine but always be careful in placing the longer length to make
sure it can track it properly. Also, when you make a change in length and click on the Apply button for it
to be effective. It is important to launch Corel after this change is effective in LinkMotion. Design
applications read the available maximum size from the driver when it is launched.
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9. I made changes in Cutter Speed and cutter pressure but it does not seem to be
effective. Why?

After making a change you might have not clicked on the Apply button. It is important to remember to
click on the Apply button for it to be effective for all of the changes in LinkMotion applet.

10. Why is Cutter Pressure grayed out for my vinyl cutter?

Your Vinyl cutting machine may have the manual pressure adjustment and software controlled
command for the pressure may not be available.

11. My vinyl cutting machine is not listed in the selection of list of machines in
LinkMotion driver. What can I do?

It is easy enough for us to add another machine in our list of Machines as long as we have information

on your vinyl cutting machine. Please provide information on all HPGL commands it uses along with
the cutting width and length, as well as resolution it works with. Please provide as much information as
possible to your supplier and we can include your machine.

12. I have setup and customized LinkMotion for my needs. Now, you sent me
information for new version of LinkMotion. How can I preserve my settings while
upgrading to a new version?

It is very easy. Follow the uninstall instruction (from the end of the document) from installation
instructions. Remember to first save your older configuration file and then uninstall. Now install the new
version and bring back you older configuration file from General Options tab by Load button. Re-
Launch LinkMotion driver one time and then work with your new version.

Section III - LinkMotion and Corel Draw:

1. How can I change starting positions of a job?

Starting position is controlled by what you select in Corel’s print preview selection under Layout Tab.

2. Why is my job being cut goes back and forth all over the vinyl cutter?

Corel generally will output jobs in the order that it was designed. If you wish to see a different order
then you need to use Corel’s object manager and organize the output properly. LinkMotion and Corel
Draw document has more detail explanation.

3. How can I design a job in Corel that uses several colors of vinyl?
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Corel allows you to design job in layers. LinkMotion and Corel Draw document has more detail
explanation of how to design jobs in layers.

4. How can I duplicate my design to cut several times?

LinkMotion and Corel Draw document has more detail explanation of how to duplicate jobs in Corel.
Corel allows you to duplicate jobs very easily ahead of time.

5. Can I cut the same job again since it was not cut properly for easy weeding?

Yes, only if End of job action in LinkMotion is selected to Rewind vinyl to re-run the job before
sending the job. User should always do preliminary testing for the vinyl you are using for proper
weeding and then send the job for production.

6. Can I cut any part of the job again without sending a complete job again?

Yes, Select the objects you want to send to the vinyl cutter from your page design and then select Print
from the File menu. Now make sure to check Selection on the Print dialog box, make sure your output
position in layout tab is correct and then click on the Print button to send the job. Only selected job
should go to the machine.

7. Can I use other design applications to send my job to a vinyl cutter?

Yes, you can use other applications as long as the design application is capable of sending a vector
output file. Design application should allow you to design shapes with thinnest line or hairline or zero
line width and no fill. Word processing type applications are not capable of sending the vector output.
Please check with your supplier for more information.

8. What can I do to get more help?

A dedicated website is setup where users can exchange information and help each other. Do visit the site
frequently. Click on LinkMotion logo after launching LinkMotion applet. If your PC is connected to
internet, it will take you to the website.
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